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Copyright 
Information contained in this manual is subject to change 
without notice and does not represent a commitment by 
Vision numeric SA. The software described in this 
manual is provided under license agreement and may be 
used or copied only in accordance with the terms of such 
license. No part of this publication may be translated, 
reproduced or transmitted in any form or by any means 
(electronic or mechanical) for any purpose without the 
express permission of Vision numeric SA. 
 
Copyright © Vision numeric SA 2004 – R 040603 
 
Important 
Vision numeric SA shall not be responsible for any loss 
(including, but not limited to profits) or damages 
whatsoever arising out of or related to this manual, or the 
use of the product, or any use thereof. 
 
Trademarks 
Type3 is registered trademark of Vision numeric SA. 
Microsoft, Windows are registered trademarks of the 
Microsoft Corporation. 
Other trademarks that appear in this publication are the 
property of their respective holders.  
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A. HARDWARE 

 
− Processor 2GHz Pentium IV, 
− RAM 512 MB, 
− Available disk space 1 GB, 
− Monitor/screen (resolution: 1024*768 in 16 

bits), 
− USB port or a Network card 
− Video card: NVIDIA GeForce III (64 or 128 MB), 
− Three-button mouse. If you have a two-button 

mouse, refer to the Appendix of the 3DESIGN> 
jewel Exercise book to discover useful 
shortcut keys. 

 
 

B. SOFTWARE 
 

− Microsoft Windows 2000, Windows XP, 
− Any Web browser if you want to download 

updates from the 3DESIGN web site and get 
Bonuses (to do so, it is strongly advised to have 
a high-bandwidth connection)! 

 
 

Warning  
 
These are the recommended minimum requirements. You 
may run 3DESIGN software with a less powerful 
configuration, but the calculation time will be higher and 
the software running less optimized (e.g., display delays). 
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A. INSTALLATION STEPS 

 
You can install 3DESIGN software from the CD-ROM that 
we sent you. Just follow the instructions to install it 
correctly. 
 

1. Close all programs. 
2. Insert the 3DESIGN CD into your CD-ROM drive. 

The installation starts automatically, if not, follow 
the steps 2b, 2c and 2d. 
2b. Run Windows Explorer. 
2c. Select your CD-ROM drive. 
2d. Double-click on setup.exe. 

3. Follow the instructions displayed on the screen.  
4. Once the installation completed, restart your 

computer. 
 
 

B. USING THE USB DONGLE 
 
The USB dongle plug-in does not require to turn off your 
computer. It is automatically taken into account.  
Be careful, you have to unplug the USB dongle BEFORE 
installing the software. Plug it before launching 3DESIGN. 
 
 

C. LICENSE ACTIVATION 
 
Your 3DESIGN application may work with or without a 
dongle. If you use a dongle, the license is linked to it and 
can be transferred from a computer to another but always 
for a single user. On the contrary, if you do not have any 
dongle, the license is linked to the computer and cannot 
be transferred. In this case, it is necessary to have an 
Internet connection. 
 
If you are connected to the Internet, the license is 
updated on the website and the application will 
automatically find it. 
If you are not connected, open the license file (with the 
*.lic extension) that we provided you. 
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If you do not have this license file, send us your User 
identifier by e-mail and we will send you back the 
corresponding license file. To get your User identifier, just 
launch 3DESIGN, the User identifier code is displayed in 
the starting dialog box. 
 
If you do not have a license file nor a dongle (in case you 
have just downloaded the software from our web site), 
then you are will receive by e-mail a link that redirect you 
to the 3DESIGN web site to select and order your license. 
 
Thanks to your Internet connection, you will be able to 
download 3DESIGN updates. This way, you will always 
have the most up-to-date version of the software. 
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A. INSTALLATION VIA THE INTERNET 

 
You can download 3DESIGN software and its updates from 
the Internet. 
Even if you have already installed 3DESIGN on your 
computer from the CD-ROM, you need to install it again 
via the Internet to update 3DESIGN. 
To do so, connect you to the website 
http://www.3designjewel.com, select the Try 3DESIGN 
thumbnail and follow the instructions. 
After filling in your personal data, you will receive an e-
mail allowing you to enter the “3DESIGN Community”. 
Connect you to the 3DESIGN web site thanks to the link 
given in the e-mail. You can then launch the installation of 
3DESIGN. 
 
 
If your license has not been activated yet, you need to do 
it. Refer to the corresponding section to know the 
activation process. 
 
 
 

B. LIVE UPDATES 
 
Thanks to your maintenance contract, you have the 
possibility to always have the most up-to-date version of 
the software. 
As soon as the software is improved or when a new 
function is released, you can download the latest version 
without any delay. 
Do not hesitate to contact our sales department for 
further information (salesdpt@type3.com). 
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In this chapter, you will find a quick description of the 
3DESIGN architecture. Get the gist of it and afterwards 
find out more by yourself… 
 
 

A. LAUNCHING THE SOFTWARE 
 
When you run the software, it opens on a web page. 
Then, you have two options: to visit the 3DESIGN 

homepage  or to start working! 
The 3DESIGN homepage presents information about the 

product , the possibilities it offers and the results 
you may obtain. On this page, you will have at your 

disposal some examples  and general information 

 about the software running before creating your 
own pieces. 
If you prefer to start working at once, create a new part, 
a new sketch, or open a recent document, click on the 

corresponding icon . 
 
 
Even if you want to start working on an imported 
document, you need to create a new part before. The 
import and export formats are for example: IGES, STEP, 
VDA-FS, SMS SAT files… 
For some functions, you may import *.jpg, *.gif, or *.png 
files. 
Finally, you can save your work in the 3DESIGN format: 
*.vtf. 
All managing files possibilities are available under the File 
menu. 
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You can open several windows at the same time. The 
windows can edit the same document or each window can 
edit a different document. 
To open another window when one is already working, 
select the Window menu > New window. 
 
 
Be careful, working with several windows requires more 
resources from your computer; make sure it is powerful 
enough before starting several sessions. 
(See I. Operating and System requirements). 
 
 
 

B. THE WORKING AREA 
 
The four available tabs are the Tree, the Properties, the 
Tools and the Help system. They can be customized as 
you like. 
For each window, you can display any tab you want and 
this way, you can set your own configuration, the most 
convenient for you. The size of the windows can also be 
modified, the central window, the Main Editor, adjusts 
automatically.  
If the size of your lateral window is too small, the tabs 
may not be visible, then move them with the tab arrows 

.  
When using the splitting arrows , you can 
maximize or minimize a tab or get back to its previous 
size. 
The Windows menu enables you to work in full screen or 
in a resizable window. 
 
Concerning the help system, you can display different 
sections at the same time (see section IV. A. Help 
system). 
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1. Tools and edition modes 
 
a. Tools   

 
The work environment is very dependent on the current 
job. Different tools are available for each edition mode. If 
you are working on a part or a sketch (what we call a 
document item), you do not have access to the same 
tools. 
It is obvious that some tools are usable for any document 
item and thus are always available. 
Many tools can be found both in the menus and in the 
Tools tab. For example, the Insert menu indicates you 
all available shapes that can be created according to your 
current Edition mode. 
When tools appear in gray, they may be available for the 
current document item but they are inactive because your 
selection has not been done completely or the previous 
operation is not completed. 
If you do not understand how to run a function, do not 
hesitate to refer to the help system. 

Handles to resize 
the lateral windows 

Separations 
between the tabs 
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Here are the tools of the … 
 
        Part module        and of the…   Sketch module 
 

              
 

 
When clicking with the mouse wheel (or the central button 
if you got a three-button mouse) on a section title, i.e. 
one blue bar, all other tool boxes close and only the one 
you select remains open. 
 
 

b. Edition modes: Part, Sketch or Rendering 
 
You can work in 3D in the Part module, draw profiles or 
shapes in the Sketch module or make nice renderings in 
the Rendering module. 
 
 

  The Part module 
This module enables you to create surfaces and solids 
such as spheres, cylinders, swept surfaces, etc. and to act 
on them by applying mirrors, Boolean operations, 
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duplications, etc. If you are in the Sketch module, you 
only have to double-click on Part in the Tree to switch 
back to the Part module. 
 
 

  The Sketch module 
With this module, you are able to draw by freehand 
curves, geometrical figures, symmetrical curves, etc. that 
you can use afterwards in the Part module as a profile or 
an extrusion path. To get into the Sketch module, you 
would be well-advised to select first the plane in which 
you will work in the Sketch module and then click on the 
Sketch icon in the Toolkit section. If no plane is 
selected, the OXY plane is assigned by default. 
To exit the Sketch module and get back to the Part 
module, you can either double-click on Part in the Tree or 

click the Exit current editor icon . 
 
 

  The Rendering module 
When working in the rendering module, you will be able to 
use very nice visual effects, to apply textures or to create 
an environment to set off your object. At the end, you will 
get a realistic rendering of your creation. 
 
 

2. Views 
 

a. Displaying mode 
 

When you open a new part, the default plane is the OXY 
plane (OX and OY axes visible). To display the hidden 

planes and axes (symbolized by a Ghost ), you only 
have to right-click on each of them and to select the Show 
option in the context menu. 
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When a plane is selected, its name appears in blue and 
italic characters and the axis or the plane itself turns 
blue. 
You can change the view angle by right-clicking on the 
planes - or on the XYZ arrows - and moving them to the 
desired position. 
You can make your object spin round: right-click on it and 
drag the mouse quickly on one side outside the Main 
editor, the object starts to turn round on itself. Just click 
in the Main editor to stop it. 
If you want to focus on a particular area of your plane, 
click the wheel and the right button of your mouse and, 
without releasing them, drag your plane on one side or 
the other. 

 
 
The XYZ arrows are always visible in 
each viewport and enable you to know 
the exact direction of the axes, if they 
do not appear clearly in the planes. 
 

 
What you see in the Main Editor is always reflected in the 
Tree, in the Axes and planes folder. Please refer to the 
section IV. C. 3. Axes and planes. 
 
 

b. View angles 
 
You can find as well at your disposal a wide range of 
different views and zooms. They are located on the right-
hand side of the Main Editor. You are therefore able to see 

any side of your creation (top , bottom , front 

, back , right , left ). It is also possible to 

have a perspective view  or to come back to the 

starting view, i.e. the isometric one . Each view is 
associated with a shortcut key to facilitate its use, e.g. the 
shortcut of the Perspective view is Ctrl+8. 
When working on a complex object, use the views to 
select one of its “hidden” sides. For example if you want 
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to twist your object vertically, it would be easier to select 
the top side if you have a top view. 
You also have the possibility to turn the view in the 

clockwise direction  or in the counter-clockwise 

direction . 
All these view options are also available in the View 
menu. 
 
 

c. Viewports  
 
Many possibilities are at your disposal to customize the 
display of the working environment. You can get only one 
display of your work in the central screen (Main Editor), 
but you can also divide it up in different ways to get a 
different representation. Many displaying modes are 
available, and you can switch from one to the other any 
time you want. The same way, you can modify the 
position and size of the various tabs. 
 
To see simultaneously different sides of your creation, you 
also have the possibility to split up the Main Editor into 
two, three or four spaces. The numerous options available 
in the menu will enable you to keep one view static, to 
work in another one and, for example, to turn the object 
in a third one in order to visualize the changes you have 
just made. 
Thus you can set the views number and position (e.g., the 
main one on the left with two small views on the right, or 
the main one at the top with three small views at the 
bottom). But it is also possible to decide which side of the 
object will be displayed, for example, when you split the 
window into two vertical spaces, you can have the 
isometric and top views or the front and right views. 
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 In the View menu, select 
the Viewport layout command, 
then select Other viewport  
layout and finally the Three  
vertical VP (L) option.  
This means that you will get  
three different views of your  
object and two of them will be  
on the left hand side. 
 
 
 

 
 
d. Zooms 

 

You can use as well several zooms, such as a zoom in  

or out , a zoom with a scale of 1  (i.e. a view of 
the normal size of the object) or with a scale equals to 10 

, a zoom on the selection  or a global zoom  
(on the whole plane). Zoom commands are also available 
in the View menu. Once you start to zoom, click in the 
Main Editor to stop it. 
You can also zoom using the mouse wheel or the shortcut 
keys Ctrl with + of the numeric keypad to zoom in and 
Ctrl with - of the numeric keypad to zoom out. 
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e. Perspective 
 
It is also possible to choose between two perspective 
views to visualize your creation: the Perspective view or 
the Orthogonal view. The Perspective view is much more 
pleasing to the eye; it is a natural view with vanishing 
lines. The Orthogonal view is more precise, and makes 
the alignment of items easier. They may seem to be very 
similar according to your zoom setting. 
 
Two different views: 
 

    
    … the orthogonal view       … and the perspective view. 
 
 

3. Main Editor context menu 
 
When working in the Main Editor, you can easily act on 
the elements by using their context menu. To do so, 
select an item (it turns blue) and right-click. 
As for the context menu of the Tree items, you can Edit or 
Delete them and you can change their appearance: Hide, 
Show and Freeze options. 
In addition to this, it is possible to zoom on the object you 
are pointing at. 
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C. THE WORK PROCESS 
 
1. Edition and selection 

 
To select an item, you can click on it in the Main Editor or 
on its name in the Tree. A selected item, a plane, an axis, 
a 3D or 2D object… appears in blue in the Main Editor and 
its name is also displayed in blue and italic in the Tree. 
Before selecting, if you want to be sure that you are going 
to select the right object, just let your cursor on it 
(without clicking). The object you are pointing on is 
highlighted. It appears in gray in the Tree. 
An edited item is displayed with a red tick next to it in the 
Tree. To edit an item, you have to right-click on its name 
and to choose the Edit item option in the context menu. 
You can also double-click on it. Both actions can be 
carried out in the Tree or directly in the Main Editor. 
Selecting an item is necessary when you want to apply a 
function on it or when you want to modify it. 
You need to edit an item if you want to modify its 
parameters. 
 
 

2. Selection order 
 
When you want to run functions that require various 
items, the selection order of these items is clearly 
indicated in the Properties tab. Each item to be selected 

is represented by a small hand . From top to bottom, 
you can then easily select all required items to run the 
function properly. 

To select an item, first click on the hand; it turns red . 
Then you can either click on the item in the Main Editor or 
click on its name in the Tree. The latter way of selection is 
very practical when your object is made of numerous 
elements. 
Moreover, you always know what kind of item you have to 
select since the corresponding icon appears at the 
beginning of the line. 
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Mirror effect parameters 
 
 

   
 
 
 
Some icons are displayed in the Properties tab to 
indicate the number of items you may select. 

When you see this Warning sign , it means that no 

item is selected. The Add icon  enables you to add 
objects when working in the List mode. First click on the 

Add icon then select one item. The Remove icon  - 
when active- allows you to suppress items. When no more 
items can be suppressed, it turns gray. 
 
When additional parameters can be set or to select 

several items, click on the double arrow  to display the 
entire parameter box. Then you can close it with another 

click on the double arrow  once you have entered all 
parameters. 
 
 
 

In the title bar, the icons 
indicate the current 
operation and that the 
selection is not completed 
(the tick is gray). 

This means that you still 
have to select an object… 

… and that the default 
symmetry plane is OYZ but 
you can change it. 
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3. Properties tab  
 
For any item, you can see and change its parameters. 
When editing an item, its parameters appear in the 
Properties tab, where you can change its position and 
dimensions. 
 
To define the position of your item, you have to enter the 
coordinates of its center, or the ones of the center of its 
base. It is possible to center automatically the item by 

clicking on the corresponding icon . 
 
The dimensions of the items can be given in positive or 
negative values. 
You also have the possibility to modify your item by 
freehand: when you edit it, it appears with a small blue 
circle that represents its center and indicates its position. 
By dragging the black arrows, you modify its Z 
coordinate. By acting on the red points, you can enlarge 
or reduce the size of the object. 
 
 
How to modify a solid by freehand: 
 

  
 

Axes origin 

Move the 
solid 
center to 
position it 
on the 
plane. 

Drag one of 
the red points 
to modify the 
dimensions of 
the solid. 
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 Click on the Cylinder icon , then, in the Main 
Editor, click once to position the center of the base of the 
cylinder. Drag the cursor laterally to define the radius and 
then vertically to define the height of the cylinder. 
 Now, you can move the whole cylinder: click on the 

blue circle  and drag it laterally or click on the 

small black arrows to move the cylinder vertically. 
 You can also adjust the size of the cylinder by clicking 

one of the red points  and dragging it. 
 When the cylinder has the correct size and positioning, 

click on the green tick  in the Properties tab to 
validate it. 
 

 
 
By default, the material assigned to any new item is the 
one chosen when launching the software for the first time. 
Nevertheless, you can change it at any time: this option is 
available for the Solid figures at the top of the 

Properties tab. Just click on the hand  next to the 
name of the material to make the corresponding dialog 
box appear. For any other item, you can change the 

material with the Set material function . 
You also have the possibility to Ungroup an object by 

material .  
(See the section about the Material database to know 
which are available and what you can create). 
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It is also possible to apply a texture on an item. By 

clicking on the double arrow , you can visualize the 
four ways to apply the texture: according to the UV axes 
of the surfaces, spherically, cylindrically (around an axis) 
or in a planar way. 
 
 

4. Preview 
 
For many tools or when re-editing an item, you can have 
an idea of the final result without validating by clicking on 

the Eye . It allows you to preview the resulting object 
while keeping the possibility to modify the parameters. 
 
 

5. Validation/Cancellation 
 
When you create an item, you always have to validate its 

properties by clicking on the Green tick . If you 
decide to cancel the operation, just click on the Red 

cross  to quit the dialog box. If you do not close the 
dialog box, you will not be able to run another function. 
For all re-edited items, you can change the parameters, 
but, to apply these modifications, you have to validate 
them with the green tick. The latter becomes active when 
the change is taken into account and visible in the central 
window (if it is inactive, just click in another field to apply 
the changes). 
If you decide not to validate your modifications, you can 
close the dialog box by clicking on the red cross and the 
original values will be kept. 
 
When validating changes of the original parameters, you 
will need to recalculate the following operations. Simply 

click on the Flag . 
(See the section IV C. 4. d. Calculators.) 
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6. Keeping track of your know-how 
 
To remember how you manage to carry out a task or to 
show it to your co-workers, you can make a screenshot or 
even a movie of your job. Available in the View menu, 

you can save your Screenshot to the Clipboard  or 

to a File  or launch the recording of the Movie . 
 
 
 

D. THE TREE  
 

The Tree  gathers all actions carried out since the 
moment you open your document. It is possible to display 
it in three different modes: Full tree (all operations), 
Simplified tree (the two first levels of operations) or 
Compact tree (first level of operations only). The Root is 
divided in two sections: one for the part, i.e. the object 
you are creating, the other one for the planes and axes. A 
third section appears for the Rendering once you have 
made it. 
 

 
The Root (to go back to the 3DESIGN Home page) 
 
Axes and planes folder 
 
Part section 
 
Rendering section 
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1. The Part 

 
When creating objects, surfaces, solids, etc. or importing 
jewelry items, all operations appear in the Part section. 
A specific folder is automatically generated when you 
create curves and geometrical shapes in the Sketch 

module, that is the Sketch section . 
The last operation performed is always on top of the list. 
Even if an operation is included in another one, you can 
still see and change its parameters. The software then 
indicates that it is necessary to recalculate the previous 
operations. See the following section (4.d) on the 
Calculators. 
 
 

2. The Rendering 
 
Once you have carried out a Rendering, the corresponding 

branch appears in the Tree . For this rendering, you 
may set various parameters such as the anti-aliasing, a 
shadow effect or a photo effect. You get an idea of the 
final result of your creation that you can pass on to your 
partners and customers. 
 
 

3. Axes and planes 
 

By default, you have at your disposal in this folder  
the three reference planes: OXY, OXZ and OYZ and the 
three reference axes: OX, OY and OZ. 
Only the OXY plane and OX and OY axes are visible when 
you start the software. You can add one or several planes 
and axes, as many as needed; they do not appear in this 
section but in the Part section. 
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4. Icons 
 

 

a. Red tick: Item in edition  
 
To edit an item in the Tree, you can double-click on it or 
you can also right-click on it and choose Edit item in the 
context menu. 
When an item is edited, it means that you get access to 
its parameters. A red tick appears next to the name of the 
item. 
 

b. Ghost: Hidden item  
 
You can alternately hide or show an item. Right-click on 
the item and choose between Hide or Show in the context 
menu. When an item is invisible, it is displayed with a 
small ghost next to it. 
 

c. Snowflake: Frozen item  
 
You can freeze an item, i.e. you can isolate it in order to 
“protect” it when carrying out an operation on the entire 
part. This function is also useful to make items 
transparent so you can see entirely elements that are 
partly hidden. 
A frozen item appears with a snowflake next to it. 
 

d. Calculators  / Flag : Recalculation after 
modifying parameters 

 
When changing the parameters of what we could call a 
“sub-operation” (an operation inside another one) you 
usually need to recalculate the following operations. In 
this case, the operations that need to be recalculated are 
displayed with a calculator next to them and the flag 
becomes active. By clicking on the flag, all operations 
previously displayed with a calculator are recalculated. 
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5. Tree context menu 

 
You can easily open the context menu of an item by right-
clicking on it. Then you have many possibilities such as:  
 

 Zooming on an item , 

 Hiding it,  

 Showing it or 

 Freezing it. 
 
The Show option enables to cancel both Hide and Freeze 
options (see above the Icons section). 
 
It is also possible to  

 Delete the item ,  

 Rename it ,  

 Transform it into a Basic element. The 
obtained entity will have no history, no 
properties and, consequently cannot be 
reedited. You can keep a composite element 
(with sub-elements, that can be ungrouped or 
filtered) or just a solid, 

 Set it as a Reference object. This is very useful 
when you apply functions on an object and 
you want to recover it with all its properties so 
as to reuse it, 

 Edit it , i.e. displaying its parameters or 

 Replace it. 
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 In the Tree, select the OXY plane. 
 Right-click on it to display the corresponding context 
menu. In this menu, choose the Hide option. 
 The plane is not visible any more in the Main Editor but 
is still present in the Tree. Only the OX and OY axes 
remain visible. 
 The fact that the item is hidden is represented by a 

Ghost . 
 

 
 
 

E. MATERIALS AND REFERENCE ELEMENTS 
 
 

1. Material Database  
 
The Material database is accessible in the Tools menu. A 
dialog box opens where you can find all available 
materials. They are divided into two groups. One is fixed 
and made of the materials supplied with the software; the 
second group is yours! You can create your own 
materials. 
Any newly created material can be edited (to modify it), 
suppressed or renamed. You also have the possibility to 
add folders to classify the materials according to your 
needs, e.g. Precious metals, Gems, etc. 
 
To create a material, select the User data folder and click 

on the Add icon . The New material appears in the 

User data folder. Double-click on it or edit it  to 
open the second dialog box to set the parameters. When 
re-editing a material, its parameters appear in the same 
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dialog box. You can then modify them and preview the 
result. 
You also have the possibility to use the pre-defined 
materials: select one of them, copy it by clicking the 

corresponding icon , select the User data folder and 

paste the material , you can then rename it and 
modify it to adapt it to your needs. 
 
 
Editing and modifying a material 
 

 
 
Many parameters are available such as: 
 

− the shape (ball or box),  

− the color  –you can use an image instead in 
order to create a texture effect - ,  

− the diffuse light  ,  

− the specular effect  ,  

− the transparency  ,  
− the reflection effect,  
− the density, etc… 

 
You can also visualize the material with a ground, a 
background and shadows, which is advisable for some of 
these parameters. 

Each time you modify 
a parameter, you can 
visualize the possible 
result by clicking on 
the Eye. 
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Parameters are presented as drop-down fields, just click 
on the double arrow to open or close a field. 
It is important to set accurately these parameters because 
they have an influence on the quality of your rendering. 
 
 

2. Catalog  
 
The Catalog contains elements that are standard 
components for rings, pendants, earrings, bracelets… or 
items that can help you in your creation such as pre-
drawn sections or rendering tools. 
It is also possible to import rings that are already 
completely made. 
You have the possibility to create easily any kind of jewels 
using the Catalog. There, you will find a lot of settings, 
stones, rings… at your disposal. 
You can use them to realize your project but you can also 
add items you created if you use them frequently. Then 
you can expand this component database as you need. 
This way, you can create a whole set of jewels. You only 
need to save them as symbols. 
 
It is very easy to export a symbol. Once you created the 
item you want to export (a ring, a link, etc.), select File 
menu > Export command. Give a name to your symbol 
and choose the *.smb format. A dialog box gets 
displayed that allows you to create a small image that will 
illustrate your symbol in the Catalog. 
The JPG file format is automatically applied to the image. 
Both elements (the symbol and the image) are stored in 
the directory. 
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Here is an example of a ring creation with three standard 
components: 
 

            
 

 
 
 

 

 Click on the Catalog icon . A dialog box gets 
displayed where you can choose to import a ring, a 
setting, a stone, etc. Double-click on the item you want to 
import. 
 In the Properties tab, the name of the item appears at 
the top of the tab and you can then choose the reference 
plane, the size and the position of the item. Any change in 
the properties is automatically visible in the Main Editor, 
so you can act very precisely. 
 When completed, validate the import by clicking the 

green tick . 
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A. THE HELP SYSTEM: 

A CONTEXT-SENSITIVE COMPANION  
 
 
Thanks to the different tabs, you can display the content 
of the topics in one tab and the table of contents in 
another one. Therefore you are able to work by following 
the instructions of the help topic that corresponds to your 

current operation. The Help tabs  may be interactive 
or not. 
 
 

1. Context-sensitive help 
 
To activate this help mode, you have to select the Context 
help command in the Help menu or press Shift+F1. The 

cursor turns into a question mark , then you can click 
on the icon of which you want to get the explanation. 
 
 

2. Automatic context-sensitive help 
 
As a faithful companion, the context-sensitive help starts 
automatically on the appropriate topic when the cursor 
remains a few seconds on a tool. It is active by default, 
but you can deactivate it by pressing Ctrl+F1 or 
deselecting Auto-context help in the Help menu. 
 
 

3. Help in the Properties tab 
 
When launching a function, you can call the help 

whenever you need by clicking on the Help icon  of 
the function Properties tab.  
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What are the Help tabs for? 
 

  
 
 

 
 
 In one lateral window, open the Help tab on the 

Content thumbnail . In another lateral window, open 

the Help tab on the Viewer thumbnail .  
Now, let your mouse cursor a few seconds on an icon, 

for example, the Rotation icon . 
 The content of both Help tabs is updated, the 
corresponding topic gets displayed in the Viewer part, 
and the title of the function appears in the Content (i.e. 
the table of contents). 
 

 

Contents 

Index 

Viewer: 
topic content 

Search 
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B. FULL 3D SAMPLES 

 
You have at your disposal some 3D examples that will 
show you how easy it is to create jewels in 3DESIGN. They 

are available from the 3DESIGN homepage . Click 

on this icon  to display the page.  
 
 
 

C. GETTING STARTED WITH 3DESIGN  
 
In order to discover the numerous possibilities of 
3DESIGN, you can work on exercises especially created for 
you. They are available in the 3DESIGN> jewel Exercise 
book. 
 
Follow carefully the different steps that will guide you 
through the creation of simple examples. You will quickly 
understand how to use the many tools at your disposal 
and you will be fully capable to carry out your own 
projects. 
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